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Preface

The Empirica Signal application provides the ability to generate reports on topic 
content using Oracle® Business Intelligence Enterprise Edition (OBIEE). This guide 
provides system requirements and configuration instructions to integrate OBIEE with 
the Empirica Signal application.

The preface includes the following sections: 

■ Audience

■ Documentation accessibility

■ Related documents

■ Conventions

Audience
This document is intended for database administrators, Empirica Signal 
administrators, and IT administrators.

This guide assumes that you have an understanding of operating system and database 
concepts, and have experience using the supporting software as described in the 
Installation requirements chapter. This guide assumes you have both the Empirica 
Signal software and OBIEE already installed.

Documentation accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related documents
For more information, see the following documents in the Oracle Health Sciences 
Empirica Signal Release 8.0 documentation set:

■ Oracle Health Sciences Empirica Signal and Topics User Guide

■ Oracle Health Sciences Empirica Signal Release Notes



viii

■ Oracle Health Sciences Empirica Signal Known Issues

■ Oracle Health Sciences Empirica Signal Installation Guide

■ Oracle Health Sciences Empirica Signal Secure Configuration Guide

■ Oracle Health Sciences Empirica Signal Third Party Licenses and Notices

■ Oracle Health Sciences Empirica Topics API Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Installation requirements 

To use OBIEE to report on the Empirica Signal and Topics application, you must meet 
the requirements specified in this chapter. 

This chapter includes the following sections:

■ Database requirements

■ Oracle Business Intelligence requirements

■ Empirica Signal requirements

Database requirements
Obtain the following information:

■ SYSTEM password for the Oracle database instance used by the Empirica Signal 
application.

■ Name of the Empirica Signal application database account and tablespace.

■ TNS name used for database access from Empirica Signal and OBIEE.

Oracle Business Intelligence requirements
■ Oracle Business Intelligence URL.

■ Oracle Business Intelligence administrator username and password.

■ Oracle Fusion Middleware Enterprise Manager URL.

■ Oracle Fusion Middleware Enterprise Manager administrator username and 
password.

■ Oracle WebLogic Server Administrator Console URL.

■ Oracle WebLogic Server Administrator Console administrator username and 
password.

■ Server and file system access to the OBIEE and WebLogic installation.

These software tools and installation instructions are available as downloads from 
http://www.oracle.com/technetwork.

Empirica Signal requirements
■ Empirica Signal release 8.0 or higher, installed and configured.

■ Empirica product ZIP file from the Oracle Software Delivery Cloud.
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■ File OBIEE.zip from the Oracle Software Delivery Cloud.

■ Empirica Signal URL.

■ Empirica Signal administrator username and password.

■ Empirica Signal Topics feature, installed and configured.

■ Name of the topic workflow account.

■ Topic Workflow Configuration ID for which OBIEE can generate reports.

■ Server and file system access to the Empirica Signal application server.

To create the topic workflow account during the Empirica Signal installation, see the 
Installation Guide.

Note: Before you configure Oracle Business Intelligence for Topics 
reporting, you must ensure that you have the installation media, such 
as the product ZIP file that corresponds to the release of the Empirica 
Signal software that you installed. The procedures for configuring 
Oracle Business Intelligence require files that are provided on the 
installation media.
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2Prepare the Empirica Signal data account

In this step, you create an OBIEE database account for the Empirica Signal and Topics 
application, and then populate the database account with views that point to data 
items in your chosen topic workflow configuration for reporting.

This chapter includes the following sections:

■ Creating the OBIEE Topics database account

■ Creating the OBIEE Topics views

Creating the OBIEE Topics database account
1. Extract the contents of the Database.zip file on your Empirica Signal application 

server.

2. Open the create_topics_user_obiee.sql file in a text editor.

3. Verify that the following properties are set to the appropriate values for your 
environment, and edit the values if necessary:

DEFINE TOPIC_WORKFLOW = '<topic workflow account>';

DEFINE SIGNAL = '<Signal account>';

DEFINE TABLESPACE = '<tablespace>';

4. Open a Command Prompt window (for example, PuTTY) and execute the create_
topics_user_obiee.sql script as the Oracle system user:

$sqlplus system@<TNS name for database connection> @create_topics_user_
obiee.sql

5. When prompted, type the Oracle system account password.

A list of topic workflow configuration names and IDs appears.

6. When prompted, type the target topic workflow configuration ID.

The script creates the OBIEE_<topic workflow account>_<topic workflow ID> database 
account.

7. When prompted, choose and type a password for the OBIEE_<topic workflow 
account>_<topic workflow ID> database account.

Record this password for use in the next section and later.

Note: The database may reside on a different server than the Signal 
server.
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The script completes, and creates the create_topics_user_obiee.log file.

Creating the OBIEE Topics views
1. On the Empirica Signal application server, locate the populate_obiee_topics.sql 

file in the contents extracted from the Database.zip file.

2. Open the populate_obiee_topics.sql file in a text editor.

3. Verify that the following properties are set to the appropriate values for your 
environment, editing the values as necessary:

DEFINE TOPIC_WORKFLOW = '<topic workflow account>';

DEFINE SIGNAL = '<Signal account>';

4. Open a command prompt window and execute the populate_obiee_topics.sql 
script as the database user created in Creating the OBIEE Topics database account:

$sqlplus OBIEE_<topic workflow account>_<topic workflow ID>@<TNS name for 
database connection> @populate_obiee_topics.sql

5. When prompted, type the password for the OBIEE_<topic workflow account>_<topic 
workflow ID> database account that you created in Creating the OBIEE Topics 
database account.

6. When prompted, type the same topic workflow configuration ID that you entered 
in step 6 in Creating the OBIEE Topics database account.

The script completes, and creates the populate_obiee_topics.log file.
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3Configure OBIEE authentication

In this step, you install and configure the authentication plugin that allows you to 
access Topics reports in OBIEE using your Empirica Signal password.

This chapter includes the following sections:

■ Configuring the credential store

■ Copying and extracting the authentication files

■ Creating a new authentication provider

■ Verifying attribute information

Configuring the credential store
1. Log into the Oracle Fusion Middleware Enterprise Manager using the WebLogic 

administrator username and password. You can access the server at:

http://<server name>:<port>/em

2. Expand WebLogic Domain in the left-hand pane.

3. Click the name of your Empirica BI domain (for example, empirica_bi), and select 
WebLogic Domain/Security/Credentials from the drop-down menu, under your 
domain name in the top left of the center pane.

4. Click Create Map and type oracle.hsgbu.empirica as Map Name.

5. Click OK.

6. Select oracle.hsgbu.empirica in the Credential column, and click Create Key.

7. Create the following keys:

■ DatabaseCredentials—Use the same user name and password as the 
corresponding DatabaseCredentials key on the Signal instance

■ AuthenticatorCredentials—Use the WebLogic administrator user name and 
password from the current OBIEE instance.

8. Select WebLogic Domain > Security > System Policies from the drop-down menu 
under your domain name in the top left of the center pane.

9. From the Type drop-down list, select Principal.

10. Click Create. 

11. Under Permissions, click Add. Select the Select here to enter details for a new 
permission check box, and type the following values:
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Permission Class: 
oracle.security.jps.service.credstore.CredentialAccessPermission

Resource Name: context=SYSTEM,mapName=oracle.hsgbu.empirica,keyName=*

Permission Actions: read

12. Click OK.

13. Set the drop-down selector Grant to to Principal.

14. Under Grantee, do the following:

a. Click Add.

b. Set the Type drop-down list value to Group.

c. Set the Principal Name drop-down list value to Starts With.

d. Type BI in the text field, and click the blue Search roles button.

e. Select BIAdministrators.

f. Click OK.

15. Click OK.

16. Set the Type to Principal and search for entries starting with BI. Select 
BIAdministrators, and click Create Like.

17. Under Grantee, do the following:

a. Click Add.

b. Set the Type drop-down list value to Group.

c. Set the Principal Name drop-down list value to Starts With.

d. Type BI in the text field, and click the blue Search roles button.

e. Select BIAuthors.

f. Click OK.

18. Click OK.

19. Select BIAdministrators, and click Create Like.

20. Under Grantee, do the following:

a. Click Add.

b. Set the Type drop-down list value to Group.

c. Set the Principal Name drop-down list value to Starts With.

d. Type BI in the text field, and click Search roles.

e. Select BIConsumers.

f. Click OK. 

g. Click OK again.

21. The following provides access to the oracle.hsgbu.empirica Credential Store map 
for the patch directory:

a. Set the Type to Principal and search for entries starting with BI. Select 
BIAdministrators, and click Create Like.

b. Change the drop-down selector Grant to from Principal to Codebase.
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c. Enter the following value for Codebase:

file:${wls.home}/../../patch_wls1036/-

d. Click OK. 

e. Click OK again.

22. Logout.

Copying and extracting the authentication files
1. If you have not already done so, unzip the OBIEE.zip file. Open the 

OBIEE\empiricaprovider\obiee_auth.properties file and verify the information:

a. Navigate to the OBIEE\empiricaprovider directory.

b. Open the obiee_auth.properties file.

c. Verify that the following properties are set to the appropriate values for your 
OBIEE WebLogic server, editing the default values if necessary:

HOSTNAME=localhost

PORT=7001

2. Create the following folder on the OBIEE server:

/u01/app/oracle/empiricaprovider

3. Copy the following file from local folder OBIEE\empiricaprovider to the 
/u01/app/oracle/empiricaprovider folder on the OBIEE server:

■ obiee_auth.properties

■ ESAPI.properties

■ messages.properties

Copy the following files from the current Signal deployment on Linux. The file 
should be located in the stage/Signal_Install/Signal/Web_
root/WEB-INF/classes sub-directory:

■ webvdme.properties

4. Navigate to local directory OBIEE/mbeans and copy the following files to the 
<WebLogic server>/server/lib/mbeantypes folder on the OBIEE server:

■ empirica<version>.jar

■ EmpiricaCore<version>.jar

■ empiricaprovider<version>.jar

■ esapi-2.0.1.jar

■ log4j-1.2.16.jar

■ secure-coding<version>.jar

5. Add the empiricaprovider folder to the Java CLASSPATH in the Weblogic startup 
script:

a. Open a Command Prompt window (for example, PuTTY) on the OBIEE server 
and navigate to /u01/app/oracle/product/Middleware/user_
projects/domains/empirica_bi/bin (substitute your domain's name for 
empirica_bi if it is different).
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b. Open startWebLogic.sh in a text editor.

c. After the "fi" at line 127 (it ends the MEDREC_WEBLOGIC_CLASSPATH 
if-block), and before the following "echo" line, add the following two lines 
(keeping the double-quotes):

CLASSPATH="${CLASSPATH}${CLASSPATHSEP}/u01/app/oracle/empiricaprovi
der" 

PATH="${PATH}${PATHSEP}/u01/app/oracle/empiricaprovider"

d. Save the changes and close the file

6. Stop and restart the WebLogic administration server. See Appendix A, Starting 
and Stopping OBIEE for more information. 

Creating a new authentication provider
1. Log into Oracle WebLogic Server Administration Console on the OBIEE server 

using your WebLogic administrator username and password.

You can access the server at http://<server>:<port>/console.

2. In the Domain Structure pane, click Security Realms.

The Summary of Security Realms page appears.

3. In the Realms table, click myrealm.

The Settings for myrealm page appears.

4. In the Change Center pane, click Lock & Edit.

5. Click the Providers tab, and then click the Authentication subtab.

6. If SSO is configured, perform the following steps to install the 
OAMIdentityAsserter:

a. Click New.

b. Specify the following:

– Name: Type OAMIdentityAsserter.

– Type: Select OAMIdentityAsserter.

c. Click OK.

d. Click the OAMIdentityAsserter link.

– In the Common tab, make sure that OAM_REMOTE_USER is selected as 
one of the Active Types. Leave the Control Flag as OPTIONAL.

– In the Provider Specific tab, set:  
SSOHeader Name: SSO_USER_LOGIN_ID

– Click Save.

e. On the Providers page, click Reorder.

f. Move the OAMIdentityAsserter to the top of the list of authentication 
providers.

g. Click OK.

7. Click New.

The Create a New Authentication Provider page appears.
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8. Specify the following:

■ Name: Type EmpiricaAuthenticationProvider.

■ Type: Select EmpiricaAuthenticator.

9. Click OK.

The authentication provider is created.

10. On the Providers page, click Reorder. 

If the OAMIdentityAsserter is installed, move the 
EmpiricaAuthenticationProvider immediately after the OAMIdentityAsserter 
and before the DefaultAuthenticator. 

If the OAMIdentityAsserter is not installed, move the 
EmpiricaAuthenticationProvider to the top of the list of authentication providers. 

11. Click OK

12. Click the EmpiricaAuthenticationProvider link. Change the Control Flag to 
REQUISITE.

13. Click Save.

14. Click the DefaultAuthenticator link. Change the Control Flag to SUFFICIENT for 
non-SSO systems. Change the Control Flag to REQUIRED for SSO systems.

15. Click Save.

16. Click Activate Changes in the Change Center.

17. If the OAMIdentityAsserter has been installed, the following steps must be taken:

a. Save changes and shutdown all the servers in the domain. 

b. Take a backup of the $DOMAIN_HOME/bin/setDomainEnv.sh file and make the 
following changes to setDomainEnv.sh file.

Add the following lines just before JAVA_PROPERTIES are defined:

EXTRA_JAVA_PROPERTIES="-Dsso.filter.ssotoken=SSO_USER_LOGIN_ID 
${EXTRA_JAVA_PROPERTIES}" 

export EXTRA_JAVA_PROPERTIES

18. Stop and restart the WebLogic administration server. See Appendix A, Starting 
and Stopping OBIEE for more information.

Verifying attribute information
1. Log into Oracle Fusion Middleware Enterprise Manager using your WebLogic 

administrator username and password.

Note: 

■ Once the Empirica Authenticator is configured, you can no longer 
log into OBIEE using a non-Signal account.

■ The SSO properties for OBIEE's copy of webvdme.properties 
must agree with the installation. If OBIEE is configured for SSO, 
then the SSO properties must be set in webvdme.properties. 
Likewise, if OBIEE is not configured for SSO, then the SSO 
properties must not be set in webvdme.properties.
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You can access Oracle Fusion Middleware Enterprise Manager at 
http://<server>:<port>/em.

2. Expand the WebLogic Domain folder.

3. Right-click the domain name, and select System MBean Browser.

The System MBean Browser appears.

4. In the System MBean Browser pane, expand the Configuration Mbeans folder.

5. Expand the Security folder.

6. Click the myrealmEmpiricaAuthenticationProvider mbean.

The attributes appear.

7. On the Attributes tab, verify that the Value column for the 
EmpiricaSignalApplicationRoot attribute contains the 
/u01/app/oracle/empiricaprovider folder that you created in step 2 in Copying 
and extracting the authentication files.

8. Edit the value if necessary, and click Apply.

9. Log out.

10. Log into Oracle WebLogic Server Administration Console using your WebLogic 
administrator username and password.

You can access the server at http://<server>:<port>/console.

11. To make your OBIEE usernames case-insensitive to ensure successful logins from 
the Empirica Signal application, do the following:

a. In the Domain Structure pane, click the domain name. For example, empirica_
bi.

The Settings for <domain name> page appears.

b. Click the Security tab, and click the General tab if it is not already selected.

c. Click Advanced at the bottom of the page.

Advanced options appear.

d. Select the Principal Equals Case Insensitive check box.

If the check box is not editable, click Lock and Edit.

e. Click Save.

Your changes are saved.

For more information, see the following documentation:

http://docs.oracle.com/cd/E21764_01/web.1111/e13707/domain.htm

12. In the Change Center pane, click Activate Changes.

Your changes are activated.

13. Log out.

14. Stop and restart the WebLogic administration server. See Appendix A, Starting 
and Stopping OBIEE for more information.
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4Configure the Empirica Signal application

In this step, you enable OBIEE Topics reporting, assign permissions, and add the 
OBIEE URL to the webvdme.properties file.

This chapter includes the following sections:

■ Modifying the webvdme.properties file

■ Enabling the OBIEE site setting

■ Assigning permissions

Modifying the webvdme.properties file
1. Log into the Empirica Signal application server.

2. Navigate to the /u01/stage/Signal_Install/Signal/WEB-INF/classes directory.

3. Open the webvdme.properties file.

4. Add the following line, replacing <server> and <port> with the appropriate values 
for your OBIEE instance:

reportingURL=http://<server>:<port>/analytics

5. Stop, update, and restart the Empirica Signal Weblogic application server using 
the WebLogic console.

Enabling the OBIEE site setting
1. Log into the Empirica Signal application as an administrator.

2. Click Settings.

The Settings page appears.

3. Click Set Site Options.

The Site Options page appears.

4. Select the Enable OBI EE Reporting check box.

5. Click Save.

Your changes are saved.

Note: The port number can change depending on whether SSO is 
being used.
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6. Log out from the Empirica Signal application.

Assigning permissions
You must assign the appropriate OBIEE permissions to users who need access to 
Topics reports. The permissions provided in the Empirica Signal application 
correspond to the associated roles (BI Consumer, BI Author, BI Administrator) in 
OBIEE. You should assign the permissions to Empirica Signal users according to their 
roles in OBIEE.

Users must have at least the BI Consumer permission to view Topics reports in OBIEE.

1. Log into the Empirica Signal application as an administrator.

2. Click Settings.

The Settings page appears.

3. Click Edit Users.

The Users page appears.

4. Click the Action menu icon next to a user, and select Edit.

The Edit User page appears.

5. Click Assign Permissions.

The Permissions for User page appears.

6. In the OBIEE Reporting section, select the appropriate BI permissions.

7. Click Save.

Your changes are saved.
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5Install, configure, and test reports

In this step, you configure OBIEE to point to the topic workflow data, and then upload 
predefined sample reports. Further, you test the predefined Topics reports in Oracle BI 
EE to ensure the configuration was successful.

This chapter includes the following sections:

■ Updating the RPD connection pool

■ Uploading the RPD file

■ Disabling the Presentation Services cache

■ Deploying the web catalog file

■ Testing Topics reports

Updating the RPD connection pool
1. Unzip the OBIEE.zip file having the OBIEE directory onto the Windows machine 

where the Oracle BI Developer Client Tool is installed. The client tool is included 
as part of the OBIEE installation at the following location (depending on your 
installation): 

/u01/app/oracle/fmw/Oracle_BI1/clients/biserver/biee_client_install_
x64.exe.

This is a self-extracting archive that installs the client tool and other utilities. The 
same package is downloadable from the OBIEE application itself:

a. Log into OBIEE.

b. Navigate to the Home page.

c. Go to Download BI Desktop Tools.

d. Select the 32-bit or 64-bit Oracle BI Client Installer.

2. Open the Oracle BI Developer Client Tool on Windows:

a. Click Start, and select All Programs.

b. Select Oracle Business Intelligence Enterprise Edition Plus Client, and click 
Administration.

3. From the File menu, select Open, and click Offline. 

A dialog box appears.

4. Locate and open OBIEE\reporting\twc_repository.rpd file.

5. Click OK.
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6. When prompted, type the repository password. 

Oracle provides a default password of abcd1234.

7. From the File menu, click Change Password.

The Change Repository Password dialog box appears.

8. In the Old Password field, type the default password of abcd1234.

9. Type and confirm a new password for the repository, and record it for later use.

10. Click OK.

11. In the Physical pane, expand the TWC node.

The TWC subnode appears.

12. Right-click the TWC subnode, and select Properties.

The Connection Pool - TWC dialog box appears.

13. Select the General tab if it is not already selected.

14. Edit the following:

a. In the Data source name field, specify the entire connection string for your 
Empirica Signal Topics database server. Use the corresponding tnsnames entry 
for the database server (minus the leading alias names) as a starting point, and 
remove any new lines or returns.

If you choose to enter the net service name as defined in the tnsnames.ora file, 
see the associated documentation at:

http://docs.oracle.com/cd/E17904_01/bi.1111/e10540/deploy_
rpd.htm#CHDJDIJI

b. In the User name and Password fields, type the username and password of 
the OBIEE database account that you created in Creating the OBIEE Topics 
database account. 

c. Click OK.

15. When prompted, confirm the password, and click OK.

The Connection Pool - TWC dialog box closes.

16. From the Tools menu, click Update all row counts to test the connection to your BI 
Server.

■ If successful, row counts are available on the Physical pane (by mouse-over of 
the components).

■ If unsuccessful, an error occurs. To troubleshoot, check your database settings.

17. From the File menu, click Save.

18. When prompted to check for global consistency, click No.

The Oracle BI Developer Client Tool saves the changes.

19. From the File menu, click Close.

20. From the File menu, click Exit. 

The Oracle BI Developer Client Tool closes.
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Uploading the RPD file
1. Log into Oracle Fusion Middleware Enterprise Manager on the OBIEE server 

using the WebLogic administrator username and password.

You can access the server at http://<server name>:<port>/em.

2. In the left pane, expand the Business Intelligence folder, and click 
coreapplication.

The coreapplication page appears.

3. Click the Deployment tab, and then click the Repository subtab.

4. Click Lock and Edit Configuration above the Capacity Management tab.

5. Click Close.

A confirmation message appears. Click Close in the confirmation message dialog 
box.

6. In the Upload BI Server Repository section, click Browse next to the Repository 
File field.

The Choose File to Upload dialog box appears.

7. Navigate to the OBIEE\reporting folder on the Windows machine.

8. Select the twc_repository.rpd file edited in the previous section, and click Open.

The Choose File to Upload dialog box closes.

9. Type and confirm the repository password in the Repository Password field and 
the Confirm Password field using the password that you chose in step 9 in 
Updating the RPD connection pool.

10. In the upper-right corner of the BI Server Repository section, click Apply.

11. Click Activate Changes above the Capacity Management tab.

A confirmation message appears. 

12. Click Close.

13. Restart Oracle Fusion Middleware:

a. Click the Overview tab.

b. In the System Shutdown & Startup section, click Restart.

A confirmation message appears.

c. Click Yes.

14. Log out.

Disabling the Presentation Services cache
The values in an OBIEE topics report are cached due to performance considerations. 
An OBIEE user viewing topics reports may not be seeing the most recent data from the 
Empirica Signal application. By default, OBIEE caches report values for a minimum of 
10 minutes and a maximum of 60 minutes depending on the system load. The 
following configuration change disables the OBIEE Presentation Services cache:

1. Edit the instanceconfig.xml file in the directory <MW_HOME>/<ORACLE_
INSTANCE>/config/OracleBIPresentationServicesComponent/coreapplicatio
n_obips1.
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Depending on your OBIEE installation, <MW_HOME> might be similar to 
/u01/app/product/oracle/fmw and <ORACLE_INSTANCE> might be similar to 
instances/instance1.

2. Add the following lines to the instanceconfig.xml file immediately after the 
<ServerInstance> tag:

 <Cache>
   <Query>
     <MaxExpireMinutes>-1</MaxExpireMinutes>
     <MinExpireMinutes>-1</MinExpireMinutes>
     <MinUserExpireMinutes>-1</MinUserExpireMinutes>
   </Query>
 </Cache>

3. Disable the query cache:

a. Log into the Fusion Middleware Enterprise Manager using the WebLogic 
administrator username and password.

b. Navigate to Business Intelligence > Core Application.

c. Click the Capacity Management tab followed by the Performance tab.

d. Click Lock and Edit Configuration.

e. Clear the Cache Enabled check box.

f. Click Apply.

g. Click Activate Changes.

h. Click the Restart to apply recent changes link at the top of the page.

i. Click Restart.

j. Click Yes.

Deploying the web catalog file
1. Log into OBIEE using a Signal superuser username and password.

■ If OBIEE is not configured for SSO, use a Signal superuser account which 
doesn't have SSO enabled. 

■ If OBIEE is configured for SSO, use a Signal superuser account which has SSO 
enabled.

You can access OBIEE at http://<server name>:<port>/analytics.

2. Under the Search field at the top of your screen, click Catalog.

The Catalog tab appears.

3. In the top-most portion of the left pane, select Shared Folders.

4. In the Tasks section of the left pane, click Unarchive.

The Unarchive dialog box appears.

5. Next to the Archive file field, click Browse.

The Choose File to Upload dialog box appears.

6. Navigate to the OBIEE\reporting folder.

7. Select the twc_repository.catalog file, and click Open.

8. Specify the following:
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Replace: None

ACL: Inherit

9. Click OK.

The web catalog file is deployed.

Testing Topics reports
When you have completed all configuration steps, you should test the predefined 
Topics reports in OBIEE to ensure the configuration was successful.

1. Log into the Empirica Signal application.

2. Click the Topics tab.

The Topics page appears.

3. Click Report.

If SSO is configured, the Topics Dashboard should appear. If SSO is not 
configured, the OBIEE login page appears. In this case log into OBIEE using the 
Empirica Signal username and password.

If the Topics Dashboard does not appear, do the following to access Topics reports:

1. At the top of the page, click Catalog.

The Catalog tab appears

2. In the Folders pane, expand Shared Folders.

3. Expand the Topics subfolder.

4. Expand My Dashboard, and click Topics.

Topics reports appear.

5. Click Open next to a report to open it.
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AStarting and Stopping OBIEE 

Note that in your environment, some paths and locations of files may be different 
because your system may have been configured differently from the examples in the 
following sections. 

Starting OBIEE
1. Sign onto the Linux server using the non-privileged username (for example, 

oemora).

2. Start the node manager.

a. cd /u01/app/oracle/product/fmw/wlserver_10.3/server/bin

b. nohup ./startNodeManager.sh &

3. Start OHS (skip this step for non-SSO systems).

a. cd /u01/app/oracle/product/fmw/Oracle_WT1/instances/instance2/bin

b. ./opmnctl startall

c. Verify startup using command ./opmnctl status

4. Start the WebLogic administration server.

a. cd /u01/app/oracle/product/fmw/user_projects/domains/bifoundation_
domain/bin

b. nohup  ./startWebLogic.sh &

5. Start OBIEE server using WebLogic Server Admin Console.

a. Login into the WebLogic Server Admin Console using the WebLogic 
administrator username.

b. In the Domain Structure pane on the left, expand Environment.

c. Under Environment, select Servers.

d. In the Summary of Servers pane, select the Control tab.

e. Click the check box next to bi_server1, and click the Start button.

f. Watch bi_server1 until it starts (usually around 2-3 minutes).

6. Start opmnctl processes.

a. cd /u01/app/oracle/product/fmw/instances/instance1/bin

b. ./opmnctl startall
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c. Verify startup using command ./opmnctl status. Repeat until all processes 
show status of Alive.

d. If any process fails to start, try command ./opmnctl restartproc

Stopping OBIEE
1. Sign onto the Linux server using the non-privileged username (for example, 

oemora).

2. Stop opmnctl processes.

a. cd /u01/app/oracle/product/fmw/instances/instance1/bin

b. ./opmnctl stopall

3. Stop OBIEE server using WebLogic Server Admin Console.

a. Login into the WebLogic Server Admin Console using the WebLogic 
administrator username.

b. In the Domain Structure pane on the left, expand Environment.

c. Under Environment, select Servers.

d. In the Summary of Servers pane, select the Control tab.

e. Click the check box next to bi_server1, and click the Shutdown button.

f. Watch bi_server1 until it shuts down (usually less than a minute).

4. Stop the WebLogic administration server.

a. cd /u01/app/oracle/product/fmw/user_projects/domains/bifoundation_
domain/bin

b. ./stopWebLogic.sh

5. Stop OHS (skip this step for non-SSO systems).

a. cd /u01/app/oracle/product/fmw/Oracle_WT1/instances/instance2/bin

b. ./opmnctl stopall
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BTroubleshooting

This appendix describes an error you might encounter and the workaround for it.

Error during activation of changes while adding the 
EmpiricaAuthenticator authentication provider

Occasionally you may experience an error during the activation of changes while 
adding the EmpiricaAuthenticator authentication provider. The error may be similar 
to Figure B–1.

Figure B–1 Error message during activation of changes while adding the 
EmpiricaAuthenticator authentication provider.

The most direct workaround is to re-boot the Linux server hosting OBIEE, and re-start 
OBIEE. Linux may be rebooted by logging into the server as a privileged user and 
issuing the command sudo reboot. 
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CUpgrading OBIEE

The Signal 8.0 version of the Empirica Authenticator requires 64-bit Oracle Business 
Intelligence Enterprise Edition release 11.1.1.7.+ with WebLogic Server 10.3.6.0.

Empirica Signal upgrades include updated versions of the OBIEE RPD and catalog 
files. You must upload the updated RPD file and re-deploy the web catalog file after 
upgrading your Empirica Signal installation. However, if you have customized your 
RPD file or your web catalog file, you must contact Oracle for assistance in order to 
avoid losing any customizations.

Upgrading OBIEE consists of the following tasks:

■ Upgrading the OBIEE Topics views

■ Un-installing the previous Empirica Authenticator

■ Installing the new Empirica Authenticator

■ Updating the RPD file and re-deploying the web catalog file

Upgrading the OBIEE Topics views
If the Signal upgrade is referencing a different topic workflow configuration than 
before the upgrade, follow the directions specified in Chapter 2, Prepare the Empirica 
Signal data account. This will create and populate a new OBIEE_TOPIC_
WORKFLOW_n schema.

If the Signal upgrade is referencing the same topic workflow configuration as before 
the upgrade, the existing OBIEE_TOPIC_WORKFLOW_n schema may be reused. 
However, the views in the OBIEE_TOPIC_WORKFLOW_n schema will need to be 
refreshed.

1. Identify the topic workflow account used by the previous Signal 7.3 version of the 
Empirica Authenticator. This account will often have a name of the form OBIEE_
TOPIC_WORKFLOW_n, where n represents the topic workflow configuration ID 
of the targeted topic workflow configuration. You will need the Oracle database 
password for this account.

2. On the Empirica Signal application server, locate the populate_obiee_topics.sql 
file in the contents extracted from the Database.zip file.

3. Open the populate_obiee_topics.sql file in a text editor.

4. Verify that the following properties are set to the appropriate values for your 
environment, editing the values as necessary:

DEFINE TOPIC_WORKFLOW = '<topic workflow account>';

DEFINE SIGNAL = '<Signal account>';
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5. Open a command prompt window and execute the populate_obiee_topics.sql 
script as the database user identified in step 1.

sqlplus OBIEE_<topic workflow account>_<topic workflow ID>@<TNS name for 
database connection> @populate_obiee_topics.sql

6. When prompted, type the password for the OBIEE_<topic workflow account>_<topic 
workflow ID>

7. When prompted, type the same topic workflow configuration ID (the n value from 
step 1).

The script completes, and creates the populate_obiee_topics.log file.

Un-installing the previous Empirica Authenticator
To un-install the previous Empirica Authenticator (associated with Signal 7.3), perform 
the following tasks:

1. Stop all of the OBIEE server processes. If feasible, re-boot the server hosting 
OBIEE.

2. Locate the empiricaprovider directory on the OBIEE server. This is often located 
at /u01/oracle/empiricaprovider. 

3. Make a backup copy of all of the files in the empiricaprovider directory. After 
making backup copies, delete all of the files in the empiricaprovider directory.

4. Locate the <WebLogic server>/server/lib/mbeantypes directory on the OBIEE 
server.

5. Delete the following files from the mbeantypes directory:

■ ESAPI-1.4.4.jar

■ Log4j-1.2.16.jar

■ Secure-coding<version>.jar

■ Empirica<version>.jar

■ SignalTopicsCommon<version>.jar

■ Signal<version>.jar

■ Empiricaprovider<version>.jar

Installing the new Empirica Authenticator
To install the new Empirica Authenticator, perform the tasks specified in Chapter 3, 
Configure OBIEE authentication.

Updating the RPD file and re-deploying the web catalog file
Empirica Signal upgrades include updated versions of the OBIEE RPD and catalog 
files. You must upload the updated RPD file and re-deploy the web catalog file after 
upgrading your Empirica Signal installation. However, if you have customized your 
RPD file or your web catalog file, you must contact Oracle for assistance in order to 
avoid losing any customizations.

To upgrade the RPD file and re-deploy the web catalog file, perform the tasks specified 
in Chapter 5, Install, configure, and test reports. 
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